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��;%��;<
���ก���=��
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1. 8��.� !���G����#:�#���&�.� ����!)/$����&
���
����!0=�-��C�9!"#$��"
% �9
�
!�/:�0
��!�#����!��/�-<
����!����!�=� !�/$�� ก
�E"95.�8ก�� Adobe Flash CS 3 
�'
0�����ก!�#��"�:���3��	+ก,
.S�#$ 5  8* �'
C*ก
���!��
 0��.)�T�
��!�#���<��. 

2. 8�����&
��#:8�<�!.U� 2 �<�� �/� 
�<���#$ 1 �
�ก
�.� !���!�/:�0
��!�#����!��/�-<
����!����!�=� !�/$�� ก
�E"9
5.�8ก�� Adobe Flash CS 3 �'
0�����ก!�#��"�:���3��	+ก,
.S�#$ 5 8�<�� ���
����
)��ก!.U� 5 � ��� �/� 
   5 0�
�&+� �#�
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�&+� �
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   3 0�
�&+� .
�ก*
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   1 0�
�&+� �9���#$��� 
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�	�
�� ก�	���+�	�ก	� Adobe Flash CS3 9:�&	;��;ก�	�
��;%��;<
���ก���=��
 5 
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  1 
�:���%�?�  5.���'
!��/$��0�
�  � *�E�"<��.� !�����
����!0=�-���<
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	�
ก�	 
	�$;��!"��# 

5 4 3 2 1 
9'����
 1 9'���:�������	�
�      
1.1  ก
�!�9
��
���E
-����ก!�#��      
1.2  !0�
 ��8* ����*9��      
1.3  � �����&�.� ����"��!
�      
1.4  !���0*�ก�#��
�"��!
� �/$�ก��!�/:�0
      
1.5  �#�'
8� �'
E�ก
�E"9�
�      

9'����
  2  ���%�&�9�	�������	�
�      
2.1  �9
�!�/:�0
�
� -����!�#��      
     2.1.1  �#��
�&�ก�9���
�0*�ก��"
      
     2.1.2  ����*9��ก�����&�.� �����#$�9��ก
��'
!���      
     2.1.3  ����*9��ก��ก
�.� ��ก��E"9E�ก
�!�#��ก
�
��� 

     

     2.1. 4  �#��
����)��3��<�!�/$��      
     2.1.5  �#��
��
ก�<
�!0�
 ��ก����ก!�#��      
     2.1.6  ��
��
�-��ก
��'
!���8�<* 0�<�����
!0�
 �� 

     

     2.1.7  !�/:�0
�#ก
�.���.���E09!0�
 ��ก��
�&
�ก
��� 

     

2.2  �9
�ก
�E"9�
,
      
     2.2.1  ก
�E"9�
,
&�ก�9��!0�
 ���
�0*�ก�
,
      
     2.2.2  �/$���
�0�
���9"��!
�      
     2.2.3  �
,
�#$E"9�#��
��
ก�<
�!0�
 ��ก����ก!�#��      
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 ��      
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*�	����
 8 �Dก�	�	��� ��!"��#$������%�&����	�
�����	���'�
� ����	(��)* 
              �	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%��;<
���ก���=��
 5 
              ���������

���� ?:���� 3 �� 
 

�
�ก
�.� !��� 
C�9!"#$��"
% 

X  S.D. � �������
) 
1 2 3 

9'����
 1 9'���:�������	�
�       
1.1  ก
�!�9
��
���E
-����ก!�#�� 5 5 5 5.00 0.00 �
ก�#$��� 
1.2  !0�
 ��8* ����*9�� 4 4 5 4.33 0.58 �
ก 
1.3  � �����&�.� ����"��!
� 4 5 5 4.67 0.58 �
ก�#$��� 
1.4  !���0*�ก�#��
�"��!
� �/$�ก��!�/:�0
 5 5 5 5.00 0.00 �
ก�#$��� 
1.5  �#�'
8� �'
E�ก
�E"9�
� 5 4 5 4.67 0.58 �
ก�#$��� 

!G*#$� 4.60 4.60 5.00 4.75 0.29 �
ก�#$��� 
9'����
  2  ���%�&�9�	�������	�
� 

  2.1 �9
�!�/:�0
�
� -����!�#�� 
      

      2.1.1  �#��
�&�ก�9���
�0*�ก��"
 5 5 5 5.00 0.00 �
ก�#$��� 
    2.1.2  ����*9��ก�����&�.� �����#$  
�9��ก
��'
!��� 

5 4 4 4.33 0.58 �
ก 

    2.1.3  ����*9��ก��ก
�.� ��ก��E"9E�
ก
�!�#��ก
���� 

5 5 5 5.00 0.00 �
ก�#$��� 

       2.1.4  �#��
����)��3��<�!�/$�� 4 5 5 4.67 0.58 �
ก�#$��� 
     2.1.5.  �#��
��
ก�<
�!0�
 ��ก��
��ก!�#�� 

5 5 4 4.67 0.58 �
ก�#$��� 

       2.1.6  ��
��
�-��ก
��'
!���8�<    
   * 0�<����� !0�
 �� 

5 5 4 4.67 0.58 �
ก�#$��� 

       2.1.7  !�/:�0
�#ก
�.���.���E09   
   !0�
 ��ก���&
�ก
��� 

4 5 4 4.33 0.58 �
ก 

 2.2  �9
�ก
�E"9�
,
 
        2.2.1  ก
�E"9�
,
&�ก�9��!0�
 ��
�
�0*�ก�
,
 

5 4 4 4.33 0.58 �
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�
�ก
�.� !��� 
C�9!"#$��"
% 

X  S.D. � �������
) 
1 2 3 

        2.2.2  �/$���
�0�
���9"��!
� 5 5 5 5.00 0.00 �
ก�#$��� 

        2.2.3  �
,
�#$E"9�#��
��
ก�<
�
!0�
 ��ก����ก!�#�� 4 5 5 4.67 0.58 �
ก�#$��� 

!G*#$� 4.7 4.8 4.5 4.67 0.40 �
ก�#$��� 

 
9'����
  3  9'��ก�	�	��� �ก�	�	�
�	��
3.1  ����*9��ก��!�/:�0
8* ���&�.� ���� 

5 5 4 4.67 0.58 �
ก�#$��� 

3.2  �#��
��
ก�<
�!0�
 �� 4 5 5 4.67 0.58 �
ก�#$��� 

3.3  �#��.8��0*
ก0*
�8* .���
�
!)#��)��#$
 �'
E09!ก��ก
�!�#����9 5 5 4 4.67 0.58 �
ก�#$��� 

3.4  ��ก!�#���
�
�&���
�����
�
!-9
E
��!�#��-����!����9 5 5 5 5.00 0.00 �
ก�#$��� 

3.5  �<�!������ก, ก
����ก
�.� ��ก����9 4 5 4 4.33 0.58 �
ก 
3.6  ��ก!�#���
�
�&���
�����
�
!-9
E
��!�#��-����!����9 4 4 4 4.00 0.00 �
ก 

    !G*#$� 4.50 4.83 4.33 4.75 0.43 �
ก�#$��� 
�JD�

	�� 4.62 4.76 4.57 4.65 0.38 �
ก�#$��� 

 
 
 
 
 
 
 
 
 



 

 

112

 
����	��� �ก�	��ก���������	�
�����	���'�
� ����	(��)* 

�	�
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��กก8��8* )�T�
 ��!�#����!��/�-<
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����!����!�=� !�/$�� ก
�E"9
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9'����
 1 9'���:�������	�
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 1.1  ก
�!�9
��
���E
-����ก!�#��       
 1.2  !0�
 ��8* ����*9��       
 1.3  � �����&�.� ����"��!
�       
 1.4  !���0*�ก�#��
�"��!
� �/$�ก��!�/:�0
       
 1.5  �#�'
8� �'
E�ก
�E"9�
�       
9'����
 2 ���%�&�9�	�������	�
�       
 2.1 �9
�ก
���ก8��� ��ก
�!�#��ก
����       
   2.1.1 �9
�ก
���ก8���9��� �����ก �#$�#�#��
����)��3� 
�<�!�/$��ก�� 

      

   2.1.2  )�T�
��
������9
������       
   2.1.3 �/�0��<���98* ���������
�8�ก�<
�� 0�<
�����*       
   2.1.4  ����*9��ก��!�/:�0
       
   2.1.5  �#��
��
�Z��Z9��!0�
 ��       
   2.1.6  �#ก*���3�E�ก
�&<
����!�/:�0
!0�
 ��8* 
�<
��E
 

      

2.2  �9
���*���#!�#� (Multimedia)       
   2.2.1  ก
���ก8��0�9

�!0�
 ���<
��<�ก
�E"9�
� ก
�
������!�9��
�!���-����!�#��"��!
� (Navigation) 

      

    2.2.2  �
)ก�
deก!0�
 ��"��!
�����*9��ก��!�/:�0

8* �#��
�����
� 

      

    2.2.3  �#��
������9
������E�ก
���ก8��8* ��9
��
)       
    2.2.4  �#*�ก,� 8* -�
�-���# �����ก,� "��!
�����
�
�<
��<
�!0�
 ��ก��� �����ก!�#�� 

      

    2.2.5  ����
)E�ก
�E"9!�#��.� ก����!�#��!0�
 ��       
ก��� �����ก!�#��   
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&��
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    2.2.6 ก
���ก8��ก�
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)!�*/$���0� ����*9��       
!0�
 ��ก��!�/:�0
 8* �<
��E
"�����8* �<
����
�       
9'����
 3 $����K 9;�#;�<(�D�ก�	�&��D
���กD;�       
3.1 ��ก8��.f����)��3�E095.�8ก��E"9�<
� � ��ก ��<   
ก<�E09!ก����
������-��!�9��
�!���5.�8ก��8*                                                                                                                              
�
�
�&�9��ก*���.���
���<
� X ��9�<
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3.2  �#��
�!0�
 ��-����.8��.f����)��3� (ก
�)��)� ก
� 
E"9!�
��) 

      

3.3  E09�#ก
���������	�
� ��
�"9
 ��
�!�=�-����!�#��       
3.4  !����8��E09��
�"<��!0*/�!0�
 ���
���
�
'
!.U�       
3.5  �#-9���*.g��ก*���#$!�/:�E09��ก!�#����9��!��
 0�8*  
       8ก9.h%0
 

      

3.6 E09�#ก
���������	�
� ��
�"9
 ��
�!�=� -����!�#��       
9'����
 4 $����!"D;ก�"�������	�
�����	���'�
       
4.1  ��ก8��!0�
 ��ก����ก!�#��       
4.2  �#��
�!�#���<
���$'
!��� 8�<��<�<
!�/$�       
4.3  �#ก
�E09-9���*�9��ก*��ก����ก!�#��       
4.4  �'
0�9

��
)E09�
�
�&8�����$��<
� X ��9��<
��# 
        ��
�0�
�8* ��9��<
 

      

4.5  E"9-9���
��#$!.U��
���ก �
�
�&�/$��.��<ก
�ก� �'
��9 
       5��0*#ก!*#$��-9���
��#$��9ก��!G)
 ก*�<����
���0�/� 
       !��/$��0�
��'
E09����� 0�/��'
�<��#$��<�/$���
�0�
� 

      

4.6  
��0�9

��
)��9!0�
 �� �<
�<
� 8* E"9�<��.���!�=� 
        !)
0�9
�<��.�
กก�<
�#$
 !*/$��0�9

��.�
�-�
�/� 

      

4.7  �#ก
�8�<��
� E�!�=�!)
 8�<* 0�9
��<
�!0�
 ��       
4.8  �#� ��ก
�E"9�
�&�ก�9��       
4.9  ����
)E�ก
�E"9!�#��.� ก����!�#��!0�
 ��"��!
�       
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4.10  ก
���ก8��ก�
deก (�
)!�*/$���0�) ����*9�� 
         !0�
 ��ก��!�/:�0
8* �<
��E
"�����8* �<
����
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*�	����
 9 �D�'������&���9�$���ก�	��ก����Dก�	�	��� ��!"��#$���ก�	 
              ��ก����	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%� 
              �;<
���ก���=��
 5 ���������

���� ?:���� 3 �� 
 

�
�ก
� 
� 8����
����!0=� 
-��C�9!"#$��"
% x  S  

� ���
����
) 

1 2 3 
9'����
 1 9'���:�������	�
�       
 1.1. ก
�!�9
��
���E
-����ก!�#�� 5 4 4 4.33 0.58 �
ก 
 1.2. !0�
 ��8* ����*9�� 5 5 4 4.67 0.58 �
ก�#$��� 
 1.3. � �����&�.� ����"��!
� 5 5 5 5.00 0.00 �
ก�#$��� 
 1.4. !���0*�ก�#��
�"��!
� �/$�ก��!�/:�0
 4 4 5 4.33 0.58 �
ก 
 1.5.  �#�'
8� �'
E�ก
�E"9�
� 4 4 5 4.33 0.58 �
ก 

!G*#$� 4.6 4.4 4.6 4.58 0.43 �
ก�#$��� 
 
9'����
 2 ���%�&�9�	�������	�
� 

      

 2.1 �9
�ก
���ก8��� ��ก
�!�#��  
      ก
���� 

      

    2.1.1 �9
�ก
���ก8���9��� ��
���ก �#$�#�#��
����)��3��<�!�/$��ก�� 

5 5 4 4.67 0.58 �
ก�#$��� 

     2.1.2 )�T�
��
������9
������ 5 5 4 4.67 0.58 �
ก�#$��� 
     2.1.3 �/�0��<���98* ���������
�
8�ก�<
�� 0�<
�����* 

4 5 4 4.33 0.58 �
ก 

2.1.4 ����*9��ก��!�/:�0
 4 5 5 4.67 0.58 �
ก�#$��� 
2.1.5 �#��
��
�Z��Z9��!0�
 �� 5 4 5 4.67 0.58 �
ก�#$��� 

     2.1.6 �#ก*���3�E�ก
�&<
����!�/:�0

!0�
 ��8* �<
��E
 

5 4 5 4.67 0.58 �
ก�#$��� 
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���.�
�
� (�<�) 

�
�ก
� 
� 8����
����!0=� 
-��C�9!"#$��"
% x  S  

� ���
����
) 

1 2 3 

2.2 �9
���*���#!�#� (Multimedia)       
      2.2.1 ก
���ก8��0�9

�!0�
 ��
�<
��<�ก
�E"9�
� ก
�������!�9��
�!���
-����!�#��"��!
� (Navigation) 

5 5 4 4.67 0.58 �
ก�#$��� 

       2.2.2 �
)ก�
deก!0�
 ��"��!
�
����*9��ก��!�/:�0
8* �#��
�����
� 

5 5 4 4.67 0.58 �
ก�#$��� 

       2.2.3 �#��
������9
������E�ก
�
��ก8��8* ��9
��
) 

4 5 5 4.67 0.58 �
ก�#$��� 

       2.2.4 �#*�ก,� 8* -�
�-���# 
�����ก,� "��!
�����
� �<
��<
�
!0�
 ��ก��� �����ก!�#�� 

4 4 5 4.33 0.58 �
ก 

      2.2.5 ����
)E�ก
�E"9!�#��.� ก��
��!�#��!0�
 ��ก��� �����ก!�#�� 

5 5 5 5.00 0.00 �
ก�#$��� 

       2.2.6 ก
���ก8��ก�
deก/
�
)!�*/$���0� ����*9��. 

5 4 4 4.33 0.58 �
ก 

!G*#$� 4.67 4.67 4.50 4.58 0.58 �
ก�#$��� 
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���.�
�
� (�<�)       

�
�ก
� 
� 8����
����!0=� 
-��C�9!"#$��"
% x  S  

� ���
����
) 

1 2 3 
9'����
 3 $����K 9;�#;�<(�D�ก�	�&��D

���กD;� 

      

3.1 ��ก8��.f����)��3�E095.�8ก��E"9�<
�  
      � ��ก ��<ก<�E09!ก����
������-��  
      !�9��
�!���5.�8ก��8* �
�
� 
      �9��ก*���.���
���<
� X ��9�<
� 

5 5 4 4.67 0.58 �
ก�#$��� 

3.2 �#��
�!0�
 ��-����.8�� 
      .f����)��3� (ก
�)��)� ก
�E"9!�
��) 

4 5 4 4.33 0.58 �
ก 

3.3 E09�#ก
���������	�
� ��
�"9
 
      ��
�!�=�-����!�#�� 

5 4 5 4.67 0.58 �
ก�#$��� 

3.4 !����8��E09��
�"<��!0*/�!0�
 �� 
      �
���
�
'
!.U� 

5 4 5 4.67 0.58 �
ก�#$��� 

3.5 �#-9���*.g��ก*���#$!�/:�E09��ก!�#����9 
      ��!��
 0�8* 8ก9.h%0
 

5 4 5 4.67 0.58 �
ก�#$��� 

3.6 E09�#ก
���������	�
� ��
�"9
 
      ��
�!�=�-����!�#�� 

5 4 4 4.33 0.58 �
ก 

!G*#$� 4.83 4.33 4.50 4.56 0.58 �
ก�#$��� 
9'����
 4 $����!"D;ก�"�������	�
� 
����	���'�
 

      

4.1 ��ก8��!0�
 ��ก����ก!�#�� 4 5 5 4.67 0.58 �
ก�#$��� 
4.2 �#��
�!�#���<
���$'
!��� 8�<��<�<
 
      !�/$� 

   4 5 5 
4.67 0.58 �
ก�#$��� 

4.3 �#ก
�E09-9���*�9��ก*��ก����ก!�#�� 5 5 5 5.00 0.00 �
ก�#$��� 
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���.�
�
� (�<�) 

�
�ก
� 
� 8����
����!0=� 
-��C�9!"#$��"
% x  S  

� ���
����
) 

1 2 3 

4.4 �'
0�9

��
)E09�
�
�&8�����$��<
�  
X ��9��<
��#��
�0�
�8* ��9��<
 

 
5 

 
4 

 
4 

 
4.33 

 
0.58 

 
�
ก 

4.5 E"9-9���
��#$!.U��
���ก �
�
�&�/$�
�.��<ก
�ก� �'
��95��0*#ก!*#$��-9���
��#$��9
ก��!G)
 ก*�<����
���0�/�!��/$��0�
�
�'
E09����� 0�/��'
�<��#$��<�/$���
�0�
� 

 
 
5 

 
 
4 

 
 
4 

 
4.33 

 
0.58 

 
�
ก 

4.6 
��0�9

��
)��9!0�
 �� �<
�<
� 
8* E"9�<��.���!�=�!)
0�9
�<��.�
กก�<

�#$
 !*/$��0�9

��.�
�-�
�/� 

 
5 

 
4 

 
4 4.33 0.58 �
ก 

4.7 �#ก
�8�<��
� E�!�=�!)
 8�<* 0�9

��<
�!0�
 �� 

 
4 

 
5 

 
5 

 
4.67 

 
0.58 

 
�
ก�#$��� 

4.8 �#� ��ก
�E"9�
�&�ก�9�� 4 5 5 4.67 0.58 �
ก�#$��� 
4.9 ����
)E�ก
�E"9!�#��.� ก��
��!�#��!0�
 ��"��!
� 

 
4 

 
5 

 
5 

 
4.67 

 
0.58 

 
�
ก�#$��� 

4.10 ก
���ก8��ก�
deก 
(�
)!�*/$���0�) ����*9��!0�
 ��ก��
!�/:�0
8* �<
��E
"�����8* �<
����
� 

 
4 

 
5 

 
5 4.67 0.58 �
ก�#$��� 

!G*#$� 4.70 4.70 4.70 4.60 0.46 �
ก�#$��� 
!G*#$���� 4.70 4.53 4.58 4.60 0.51 �
ก�#$��� 
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���*	�?9���'�$;�������9�$�D��� (IOC) 
�������$9���;$�D9;�P�< Q���ก�	�	�
� 

!�/$�� ก
�E"95.�8ก�� Adobe Flash CS3 �'
0�����ก!�#��"�:���3��	+ก,
.S�#$ 5 
  �'
0���C�9!"#$��"
% 

�:���%�?� 
 1. 8��.� !����#:!.U�8��.� !���!)/$����
�����
�����*9��-��8�����C*���1�3�D
�
�ก
�!�#�� !�/$�� ก
�E"95.�8ก�� Adobe Flash CS3 �'
0�����ก!�#��"�:���3��	+ก,
.S�#$ 5 
ก��!�/:�0
�#$�9��ก
���� 
  2. ��
����!0=�-��C�9!"#$��"
%�#��
��'
��%��$�E�ก
��'
�
.� ��*!)/$�0
8���
�E�
ก
�.���.���8ก9�- !)/$�!.U�.� 5�"���<�ก
�)�T�
ก
�!�#��ก
���� E09!ก��.� ���3��
)�
ก��$�-+:� 
 3. ก
�����
G��5��C�9!"#$��"
%E"9!ก�i�����#: 
 
  + 1 0�
�&+� 8�<E
�<
-9��'
&
� �����9���ก�� 
      *�ก,� ก
������!��
 0���:�
��� 
     0 0�
�&+� ��<8�<E
 0�/�������E
��<��9�<
-9��'
&
�   
      ������ก��*�ก,� ก
������!��
 0� 
  - 1 0�
�&+� ��<8�<E
�<
-9��'
&
� �����9���ก�� 
      *�ก,� ก
������!��
 0���:�
��� 
 
 
 
 
 
 
 
 
 
 
 



 

 

121

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=� 
-��C�9!"#$��"
% 

-9� 
!���8�  

E"9�����9 
 

(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

1. Adobe Flash CS 3 !.U�5.�8ก���#$�'
�
�E�
�9
�E� 

ก. ��9
��
)ก�
deก 
-. �
)!�*/$���0� 
�. ��*���#!�#� 
�. R�ก�!ก��� 

 
 

   

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=� 
-��C�9!"#$��"
% 

-9� 
!���8�  

E"9�����9 
 

(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(+1) 

2. �d*�-�� Flash "���E��#$�
�
�&�'
ก*���
 
     8ก9�-��9 

ก. .swf 
�. .fla 
�. .exe 
�. .pdf 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

3. &9
��9
��
�E0�<�.�#$!���E� 
        ก. File > Open 
      �. File > New 
        �. File > openImport 
        �. File > Edit 

 
 

   

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

4. !���E�!.U�!���!�#��ก��ก
�8ก9�- !"<� ก
� 
    
��ก
����&� 
      ก. Modify 
       -. Windows 
       �. Edit 
       �. Control 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 

-9� 
!���8�  

E"9�����9 
 

(+1) 

��<8�<E
 
 

(0) 

��<
�
�
�& 
E"9�����9 
(-1) 

5. !��/$���/�E��#$E"9�'
0���0������&� 
       ก. Free Transform 
         -. Rectangle 
         �. Selection 
         �.  Oval 

 

    

    

    

    

    
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

6. !��/$���/�E��#$E"9)��)�-9���
� 
       ก. Pen 
       -. Select 
       �. Brush 
      �. Text 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

 

7. !��/$���/�   Snap to Object �#0�9
�#$�'
 
    � ��   
       ก. �'
E09���&��
�
�&0�����9 
      �. �:��&��;*R!$��$�$���
������กD�ก;� 
       �. �'
E09���&��
�
�&-�
���9 
       �. �'
E09���&��
�
�&.���8��!�
��9 

 

    

    

    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

8. !��/$���/� Paint Bucket �#0�9
�#$�'
� �� 
       ก. ก
�0������&� 
      �. ก�	�	;��9��D��������;*R! 
       �. ก
�E�<�#)/:�E09ก�����&� 
       �. ก
�-�
�8* �<����&� 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

9. !��/$���/�E��#$E"9E�ก
���9
���ก*� 
ก. Text 
�. Oval 

            �.  Rectangle 
 �. Pencil 

    

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

10. �'
��$�E��#$E"9E�ก
� Convert ���&�E09!.U� 
      Symbol 
            ก. Insert > New Symbol 

     -. Modify > Symbol 
     �. Modify > Convert to Symbol 
     �. Insert >key Frame 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

11. Insert Keyframe �
�
�&ก�.�|�

ก 
      �#���������95��.�|�E� 

ก. F 5 
�. F 6 
�. F 7 
�. F 8 
 

    

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

12. .�|� F 5 ���#��������/�ก
��'
8��E� 
ก. Insert New Symbol 
-. Insert Keyframe 
�. Insert Layer 
�. Insert Frame 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

13. Shape Tween �#*�ก,� !.U���<
��� 
ก. �
)��$� 
�. ��#��D�
��b&������D�

�
	��	'�� 
�. �
)!�*/$���0�8��!�9���� 

            �. �
)!�*/$���0�8���#!�9� 
              Guide 

    

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

14. ก
��'
 Shape Tween ก�������ก,��9�� 
      �'
��$�E�ก<�� 
            ก. �9�� Group ก<�� 

�. Break Apart *;��;ก�	ก'�� 2 
�	;%� 
�. Break Apart �����ก,�ก<�� 1 ���:� 
�. Convert E09!.U� Symbol 8�� 
Movie Clip 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

15. ก<���'
ก
��
�!�9� Guide �9���'
��$�E� 
      ก<�� 
          ก. ��9
� Layer E0�<-+:��
 
          -. Convert ���&�E09!.U� Symbol 
          �. ��9
�.�|�E0�<-+:��
 
         �. Add Layer Guide ก'�� 

 

    

    
    
    
    

 
 

 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

16. 0
ก�9��ก
��9��ก*��ก
�ก� �'
ก<�� 
      0�9
��:� 
 �9��ก�8.g�E� 
         ก. Ctrl + z 
           -. Ctrl + B 
           �. Ctrl + Y 
           �. Ctrl + A 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

17. !��/$���/�      �#0�9
�#$� �� 
 ก.  *��#��ก

ก!�9� 
 -.  E�<�#E09ก��!�9� 
 �.  �9'9��&�ก;��;*R! 
 �.  *��#��ก

ก)/:����&� 

 

    

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

18. &9
�9��ก
���C*ก
�8���-�� Movie   
      �9��ก�.�|�E� 
 ก.  Ctrl + Shift 
 �.  Ctrl + Enter 
 �.  Shift + Enter 
 �.  Add + Shift 
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8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

19. ก
�8.*��d*�"�:��
��'
0���ก
�!C�8)�< 
      !�
!�#�ก�<
� �� 
          ก. Animation 
          -. Photograph 
          �. Account 
        �. Publish 

 

    

    
    
    
    

 
 

8����������C*���1�3�D�
�ก
�!�#�� 

��
����!0=�ก
���ก-9���� 
-9� 

!���8�  
E"9�����9 

 
(+1) 

��<8�<E
 
 

(0) 

��<�
�
�& 
E"9�����9 
(-1) 

20. ก
��
��
)!ก��

ก!��/$���/�E� 
 ก.  Line Tool 
 �.  Brush Tool 
 �.  Pen Tool 
 �.  Oval Tool 
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*�	����
10 �D����'�$;�������9�$�D��� (IOC) �������$9���;$�D9;�P�< Q���ก�	 
           �	�
� �	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%��;<
���ก���= 
           ��
 5 ���������

���� ?:���� 3 �� 
 

-9��#$ 
��
����!0=�-��C�9!"#$��"
% 

IOC 8.*C* 
���#$ 1 ���#$ 2 ���#$ 3 

-9��#$ 1 +1 0 +1 0.67 E"9��9 
-9��#$ 2 +1 0 +1 0.67 E"9��9 
-9��#$ 3 0 +1 +1 0.67 E"9��9 
-9��#$ 4 0 +1 +1 0.67 E"9��9 
-9��#$ 5 +1 +1 +1 1.00 E"9��9 
-9��#$ 6 +1 0 +1 0.67 E"9��9 
-9��#$ 7 +1 +1 0 0.67 E"9��9 
-9��#$ 8 +1 +1 +1 1.00 E"9��9 
-9��#$ 9 +1 +1 +1 1.00 E"9��9 
-9��#$ 10 +1 +1 +1 1.00 E"9��9 
-9��#$ 11 +1 +1 0 0.67 E"9��9 
-9��#$ 12 +1 0 +1 0.67 E"9��9 
-9��#$ 13 +1 0 +1 0.67 E"9��9 
-9��#$ 14 +1 +1 +1 1.00 E"9��9 
-9��#$ 15 +1 +1 0 0.67 E"9��9 
-9��#$ 16 0 +1 +1 0.67 E"9��9 
-9��#$ 17 0 +1 +1 0.67 E"9��9 
-9��#$ 18 +1 +1 0 0.67 E"9��9 
-9��#$ 19 +1 0 +1 0.67 E"9��9 
-9��#$ 20 +1 +1 0 0.67 E"9��9 
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����	��� �����#��#��?�������	�
���
��*'����	�
�����	���'�
� ����	(��)* 
�	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%��;<
���ก���=��
 5 

 
�:���%�?� 

8��.� !�����
�)+�)�E
-��C�9!�#���#$�#�<���!�#����!��/�-<
����!����!�=�  
!�/$�� ก
�E"95.�8ก�� Adobe Flash CS 3 �'
0�����ก!�#��"�:���3��	+ก,
.S�#$ 5 

 
1. 8��.� !�����
�)+�)�E
-��C�9!�#���#$�#�<���!�#����!��/�-<
����!����!�=� 

8�<�!.U�  2  �<��  �/� 
�<���#$  1  �
�ก
�.� !�����
�)+�)�E
-��C�9!�#���#$�#�<���!�#����!��/�-<
�

���!����!�=�5���#�<
� �����
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*�	����
 11 �Dก�	# ?�	"�������9��R������#��#��?����;ก�	�
��ก�

�ก;� 
               ���	�
�����	���'�
� ����	(��)* �	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 
               9:�&	;��;ก�	�
��;%��;<
���ก���=��
 5 ���������

���� ?:���� 3 �� 

�
�ก
� 
� 8����
����!0=� 
-��C�9!"#$��"
% x  S  

� ���
��
�!0=� 

8.*C* 
1 2 3 

1. ก
��#��!�#����!��/�-<
����!����!�=�
E��
���"
�#:�'
E09��!�#���#��
�
�<
��E
8* �<
!�#�� 

4 5 5 4.67 0.58 �
ก�#$��� E"9��9 

2. ก
��#��!�#����!��/�-<
����!����!�=�
E��
���"
�#:�'
E09�#C*ก
�!�#���#-+:� 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 

3. �<

 �#��!�#����!��/�-<
�
���!����!�=�E��
���"
�/$��9�� 

4 5 5 4.67 0.58 �
ก�#$��� E"9��9 

4. ก
�!�#�� !�/$�� ก
�E"95.�8ก�� Adobe 
Flash CS 3 �
�
�&�'
�..� ��ก��E"9
E�"#���.� 
'
�����9 

4 4 4 4.00 0.00 �
ก E"9��9 

5. ��!�#����!��/�-<
����!����!�=��'
E09
!�#����9��9�
กก�<
�'
�
!�#��3����
 

4 4 4 4.00 0.00 �
ก E"9��9 

6. ��ก!�#���
�
�&!�#���9����!�#����
!��/�-<
����!����!�=���ก!0�/�

ก
!�*
!�#��E�"�:�!�#����9 

5 4 4 4.33 0.58 �
ก E"9��9 

7. ก
��#��!�#����!��/�-<
����!����!�=�
�'
E09��ก!�#��	+ก,
!�/:�0
*<��0�9

ก<��!�#��E�"�:�!�#����9 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 
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�&!�#����!�#����
!��/�-<
����!����!�=���95����<
'
ก��
!�*
8* �&
��#$ 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 
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� 
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E
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��!�#���
ก-+:� 

4 5 5 4.67 0.58 �
ก�#$��� E"9��9 

10   ��ก!�#��"��E09�#!�#������
� 
       .� ก��!�/:�0
E���!�#����   
       !��/�-<
����!����!�=� 

5 4 4 4.33 0.58 �
ก E"9��9 

11   ��ก!�#����9�+ก���ก!�/$���9!�#����!�#�� 
       ��!��/�-<
����!����!�=� !�/$�� ก
�E"9 
       5.�8ก�� Adobe Flash CS 3 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 

12   ��ก!�#����9�+ก!)*��!)*��ก��ก�
ก����#$ 
       
��E09E���!�#����!��/�-<
� 
       ���!����!�=� 

5 4 4 4.33 0.58 �
ก E"9��9 

13   ��ก!�#��"���#8* ก
���ก8�� 
       0�9

�E���!�#����!��/�-<
� 
       ���!����!�=� 

4 4 4 4.00 0.00 �
ก E"9��9 

14   ��ก!�#��"����!�#����!��/�-<
� 
       ���!����!�=� !�/$�� ก
�E"95.�8ก��    
        Adobe Flash CS 3 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 

15   ��ก!�#���
�
�&���
���� 8����9 
       ����#E� ��!�#����!��/�-<
� 
       ���!����!�=� 

4 5 5 4.67 0.58 �
ก�#$��� E"9��9 

16   ��ก!�#���
�
�&����<�C�9�����9 
       � ��ก�
ก-+:� 

5 5 5 5.00 0.00 �
ก�#$��� E"9��9 

!G*#$� 4.56 4.63 4.63 4.50 0.29 �
ก E"9��9 
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12 �9$��Dก�	�	��� �����#��#��?����;ก�	�
���
��*'����	�
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               � ����	(��)* �	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%� 
               �;<
���ก���=��
 5 ?:���� 30 �� 
 

�� 
�#$ 

-9� 
1 

-9� 
2 

-9� 
3 

-9� 
4 

-9� 
5 

-9� 
6 

-9� 
7 

-9� 
8 

-9� 
9 

-9� 
10 

-9� 
11 

-9� 
12 

-9� 
13 

-9� 
14 

-9� 
15 

-9� 
16 

��� 

 1 4 5 5 5 5 5 5 5 5 5 4 5 5 5 5 5 78 
2 5 5 5 5 5 5 5 4 5 5 4 4 5 4 5 5 76 
3 4 5 5 5 5 5 5 5 4 5 4 5 4 4 4 5 74 
4 4 4 4 4 5 4 4 5 5 5 4 5 4 5 4 4 70 
5 4 4 4 4 5 4 4 5 4 4 5 5 4 4 4 4 68 
6 5 4 4 4 4 4 4 5 4 4 5 5 4 4 4 4 68 
7 5 5 5 5 4 5 4 5 4 5 5 4 4 4 5 5 74 
8 5 5 5 5 4 4 5 4 5 5 4 4 5 5 5 5 75 
9 4 5 5 4 4 4 5 4 5 4 5 4 5 4 5 5 72 
10 5 4 4 4 4 4 5 5 4 4 4 4 5 4 4 5 69 
11 5 5 5 5 4 5 5 4 5 5 5 4 5 5 4 4 75 
12 5 4 4 5 4 5 5 4 4 4 5 5 4 4 5 4 71 
13 4 4 4 5 4 5 5 4 5 4 5 5 5 5 5 4 73 
14 5 5 5 5 5 4 5 4 4 5 5 5 5 4 5 4 75 
15 4 5 5 5 5 4 5 4 5 5 5 5 5 5 5 4 76 
16 5 5 5 5 5 4 5 4 4 4 5 4 5 5 4 4 73 
17 4 4 4 5 4 5 5 5 5 4 4 5 4 4 3 4 69 
18 4 5 4 5 5 5 5 5 5 4 5 5 4 4 3 5 73 
19 4 5 4 5 4 5 5 4 4 4 5 5 4 4 4 4 70 
20 4 4 4 5 5 5 4 4 4 5 4 5 5 5 5 5 73 
21 4 5 4 5 4 5 4 4 5 5 5 4 5 5 3 4 71 
22 4 4 5 4 5 4 4 5 4 5 5 4 5 5 3 5 71 
23 5 4 4 4 4 4 5 5 4 4 4 4 5 4 4 5 69 
24 5 5 5 5 4 5 5 4 5 5 5 4 5 5 4 4 75 
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-9� 
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-9� 
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��� 

25 5 4 4 5 4 5 5 4 4 4 5 5 4 4 5 4 71 

26 4 4 4 5 4 5 5 4 5 4 5 5 5 5 5 4 73 
27 5 5 5 5 5 4 5 4 4 5 5 5 5 4 5 4 75 
28 4 5 5 5 5 4 5 4 5 5 5 5 5 5 5 4 76 
29 5 5 5 5 5 4 5 4 4 4 5 4 5 5 4 4 73 
30 5 4 4 5 4 5 5 4 4 4 5 5 4 5 4 4 71 

X  4.44 4.56 4.44 4.88 4.50 4.56 4.81 4.25 4.44 4.44 4.81 4.63 4.69 4.63 4.13 4.25 72.44 
S.D 0.51 0.50 0.51 0.43 0.51 0.51 0.43 0.49 0.51 0.51 0.47 0.50 0.49 0.51 0.71 0.49 2.66 
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 13 �Dก�	� ��	��&(�'�����
�ก	�
����D��'��:���??:���ก	�
���������9�� 
               �;$�D9;�P�< Q���ก�	�	�
�	�� 
 

-9��#$ 
��
����!0=�-��C�9!"#$��"
% 

IOC 8.*C* 
���#$ 1 ���#$ 2 ���#$ 3 

-9��#$ 1 1 1 1 1.00 E"9��9 
-9��#$ 2 1 1 0 0.67 E"9��9 
-9��#$ 3 1 0 1 0.67 E"9��9 
-9��#$ 4 0 1 1 0.67 E"9��9 
-9��#$ 5 1 1 1 1.00 E"9��9 
-9��#$ 6 1 1 1 1.00 E"9��9 
-9��#$ 7 1 1 0 0.67 E"9��9 
-9��#$ 8 1 1 1 1.00 E"9��9 
-9��#$ 9 1 1 1 1.00 E"9��9 
-9��#$ 10 1 1 1 1.00 E"9��9 
-9��#$ 11 1 1 0 0.67 E"9��9 
-9��#$ 12 1 0 1 0.67 E"9��9 
-9��#$ 13 1 0 1 0.67 E"9��9 
-9��#$ 14 1 1 1 1.00 E"9��9 
-9��#$ 15 1 0 1 0.67 E"9��9 
-9��#$ 16 1 1 1 1.00 E"9��9 
-9��#$ 17 0 1 1 0.67 E"9��9 
-9��#$ 18 1 1 0 0.67 E"9��9 
-9��#$ 19 1 0 1 0.67 E"9��9 
-9��#$ 20 1 1 1 1.00 E"9��9 
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*�	����
 14 �'�����
�ก�'�
 �'��:���??:���ก �D��'��������
��;
��������$9��  

���C*���1�3�D�
�ก
�
!�#�� -9��#$  

�<
��
��
ก�<
� 
(p)  

�<
�'
�


'
8�ก 
(r)  

ก
�8.*C*  

1  0.80 0.69 �'
�.E"9��9  
2  0.73 0.64 �'
�.E"9��9  
3  0.80 0.49 �'
�.E"9��9  
4  0.77 0.38 �'
�.E"9��9  
5  0.80 0.41 �'
�.E"9��9  
6  0.77 0.77 �'
�.E"9��9  
7  0.80 0.72 �'
�.E"9��9  
8  0.77 0.65 �'
�.E"9��9  
9  0.40 0.65 �'
�.E"9��9  
10  0.70 0.44 �'
�.E"9��9  
11  0.80 0.55 �'
�.E"9��9  
12  0.80 0.68 �'
�.E"9��9  
13  0.67 0.64 �'
�.E"9��9  
14  0.73 0.76 �'
�.E"9��9  
15  0.77 0.40 �'
�.E"9��9  
16  0.77 0.59 �'
�.E"9��9  
17  0.73 0.50 �'
�.E"9��9  
18  0.63 0.50 �'
�.E"9��9  
19  0.80 0.55 �'
�.E"9��9  
20  0.77 0.80 �'
�.E"9��9  

*�<
��
�!"/$���$�!�<
ก�� .92 
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!*-�#$ � 8��!�=�ก<��!�#�� � 8��!�=�0*��!�#�� D     D2 

20 20   

1 15 17 2 4 
2 16 17 1 1 
3 16 16 0 0 
4 16 16 0 0 
5 16 16 0 0 
6 17 17 0 0 
7 17 17 0 0 
8 17 16 -1 1 
9 16 17 1 1 
10 17 16 -1 1 
11 17 16 -1 1 
12 16 18 2 4 
13 16 17 1 1 
14 16 16 0 0 
15 17 17 0 0 
16 16 18 2 4 
17 16 17 1 1 
18 17 16 -1 1 
19 17 16 -1 1 
20 16 16 0 0 
21 17 18 1 1 
22 16 16 0 0 
23 16 18 2 4 
24 17 16 -1 1 
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  � 8��!�=�ก<��!�#�� � 8��!�=�0*��!�#�� D D2 

                20 20   

25 16 18 2 4 
26 16 17 1 1 
27 16 16 0 0 
28 15 19 4 16 
29 16 16 0 0 
30 15 16 1 1 

��� 487 502 15 49 
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�������� 16 �Dก�	� ��	��&(&��	�9 �< ��#������	�
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                    �	�
�� ก�	���+�	�ก	� Adobe Flash CS 3 9:�&	;��;ก�	�
��;%��;<
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                    �=l��
 5?:���� 30 �� 
 

����
 
������:�����$9��	�&�'���	�
� 

����� 
�$9�� 

	�&�'���	�
� 
(E1) 

����� 
�$9�� 
&D;��	�
�  
(E2) 

&�'�
��
  
1,2  

&�'�
��
  
3 

&�'�
��
  
4 

&�'�
��
  
5  

������*)� 5 5 5 5 20 20 
1 4 4 4 3 15 17 
2 4 4 4 4 16 17 
3 4 4 4 4 16 16 
4 4 4 4 4 16 16 
5 4 4 4 4 16 16 
6 5 4 4 4 17 17 
7 4 4 4 5 17 17 
8 4 4 5 4 17 16 
9 4 4 4 4 16 17 
10 4 4 4 5 17 16 
11 4 4 5 4 17 16 
12 4 4 4 4 16 18 
13 4 4 4 4 16 17 
14 4 4 4 4 16 16 
15 4 5 4 4 17 17 
16 4 4 4 4 16 18 
17 4 4 4 4 16 17 
18 4 4 5 4 17 16 
19 4 4 5 4 17 16 
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������:�����$9��	�&�'���	�
� 

����� 
�$9�� 

	�&�'���	�
�
(E1) 

�����
�$9�� 
&D;��	�
� 
(E2) 

&�'�
��
  
1,2  

&�'�
��
  
3 

&�'�
��
  
4 

&�'�
��
  
5 

������*)� 5 5 5 5 20 20 
20 4 4 4 4 16 16 
21 4 4 5 4 17 18 
22 4 4 4 4 16 16 
23 4 4 4 4 16 18 
24 4 5 4 4 17 16 
25 4 4 4 4 16 18 
26 4 4 4 4 16 17 
27 4 4 4 4 16 16 
28 4 4 3 4 15 19 
29 4 4 4 4 16 16 
30 4 4 3 4 15 16 

×∑  121 122 123 121 487 502 
 4.03 4.07 4.10 4.03 16.23 16.73 

	��
D� 80.67 81.33 82.00 80.67 81.17 83.67 
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*�	����
 17 �'��JD�

�D��'�	��
D� (E1/E2) ���กD!'��$D�� 3 �� 

D:�$;���
 
	�&�'���	�
� 

	�� 
&D;�
�	�
� &�'�
��
 1,2 &�'�
��
 3 &�'�
��
 4 &�'�
��
 5 

1 4 4 5 4 17 17 

2 4 4 4 4 16 17 

3 4 4 4 4 16 16 

������JD�

 4.00 4.00 4.33 4.00 16.33 16.67 

	��
D� 80.00 80.00 86.67 80.00 81.67 83.33 

 


ก�
�
��#$ 15 ก
���9�<
 E1 �/� 81.67 8* �<
 E2 �/� 83.33 
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 18 �'��JD�

�D��'�	��
D� (E1/E2) ���กD!'��$D�� 9 �� 

 
D:�$;���
 

	�&�'���	�
� 
 

	�� 
 

&D;��	�
� 
&�'�
��
 1,2 &�'�
��
 3 &�'�
��
 4 &�'�
��
 5 

1 5 4 4 5 18 17 

2 4 4 4 5 17 17 

3 4 4 5 4 17 16 

4 4 3 4 3 14 17 

5 4 4 4 5 17 16 

6 4 3 5 4 16 16 

7 3 4 4 3 14 18 

8 4 4 3 4 15 17 

9 4 4 5 4 17 16 

������JD�

 4.00 3.78 4.22 4.11 16.11 16.67 

	��
D� 80.00 75.56 84.44 82.22 80.56 83.33 



ก�
�
��#$ 16 ก
���9�<
 E1 �/� 80.56 8* �<
 E2 �/� 83.33 
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